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Philips Seismic Edge™
4- Channel PCI Sound Card

0O Copyright 2000
Seismic Edgel is a trademark of Philips Consumer Electronics
ThunderBird Q3D0O is a trademark of Philips Semiconductors
QSound, QEM, QSound Environmental Modeling, QSound Multi-
Speaker System, QMSS, Q3D, Qxpander, QSound3DInteractive,
AudioPix and the Q logo are trademarks of QSound Labs, Inc.

Siren is a trademark of Sonic Foundry, Incorporated

EAX and Environmental Audio Extensions are trademarks of Creative
Technology Ltd. in the United States and other countries.

Microsoft and WindowsO are registered trademarks of Microsoft
Corporation. DirectX and DirectSound are trademarks of Microsoft
Corporation.

All other trademarks are the property of their respective owners.
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Software End User License Agreement

PLEASE READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY. If you (end user, either an entity or an individual) do not
agree with these terms and conditions do not install the software. This End User License Agreement is a contract between you and Philips
Consumer Electronics B.V, including its suppliers and licensors ("Philips") for this software program ("Licensed Software"). By installing the
Licensed Software or using the Licensed Software you agree to and accept the terms and conditions of this End User License Agreement.
YOU AGREE THAT YOUR USE OF THE LICENSED SOFTWARE ACKNOWLEDGES THAT YOU HAVE READ THIS END USER
LICENSE AGREEMENT, UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS:

1. Copyright

The Licensed Software is a proprietary product of Philips, and is protected by copyright laws. Title, ownership rights and
intellectual property rights in and to the Licensed Software shall remain with Philips.

2. Right to use

Philips hereby grants you the personal, non-exclusive license to use the Licensed Software only on and in conjunction with
one (1) computer at one time. You may not sell, rent, redistribute, sublicense or lease the Licensed Software, or otherwise
transfer or assign the right to use it. You may not decompile, disassemble, reverse engineer, or in any way modify program
code, except where this restriction is expressly prohibited by applicable law. Except for one (1) copy which may be made
for backup purposes only, you may not copy the Licensed Software. You are not allowed to alter or remove any proprietary
notices, including copyright notices, in the Licensed Software.

3. Disclaimer of Warranty

THE LICENSED SOFTWARE IS PROVIDED AS IS WITHOUT WARRANTY OF ANY KIND. THE ENTIRE RISK OF USE
OF THE LICENSED SOFTWARE REMAINS WITH YOU. TO THE MAXIMUM EXTENT PERMITTED BY LAW, PHILIPS
MAKES NO FURTHER REPRESENTATIONS OR WARRANTIES EXPRESSLY OR IMPLIED SUCH AS BY WAY OF
EXAMPLE BUT NOT OF LIMITATION REGARDING MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PUR-
POSE, OR THAT LICENSED SOFTWARE IS ERROR FREE, OR THAT THE USE OF THE LICENSED SOFTWARE OR
ANY COPIES THEREOF WILL NOT INFRINGE ANY PATENT, COPYRIGHT, TRADEMARK OR OTHER RIGHT OF
THIRD PARTIES.

4. Updated
This license does not grant you the right to any upgrades or updates of the Licensed Software. However, Philips will be
entitled to offer updates and/or modifications to the Licensed Software at its discretion.

5. Changes of the agreement
No changes of this Agreement are valid unless with Philips’ and your written approval. Any terms and conditions provided

by you are inapplicable, whether or not contained in order forms or otherwise, unless by Philips in
writing by means of a duly signed addition to this Agreement.

6. Limitations of liability

PHILIPS ACCEPTS NO LIABILITY FOR ANY DAMAGES, INCLUDING ANY LOSS OF PROFIT, LOSS SAVINGS, LOSS
OF DATA, BUSINESS INTERRUPTIONS, OR ANY DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL, SPECIAL OR
PUNITIVE DAMAGES ARISING OUT OF YOUR USE OR INABILITY TO USE THE LICENSED SOFTWARE, EVEN IF
PHILIPS OR ITS REPRESENTATIVES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR
ANY CLAIM BY ANY OTHER PARTY. SINCE SOME JURISDICTIONS DO NOT ALLOW THIS LIMITATION OF LIABILITY,
THIS LIMITATION OF LIABILITY MAY NOT APPLY TO YOU.

7. Validity and Termination

The license granted hereunder shall autc i and without notice if you do not comply with all the terms and
conditions of this End User License Agreement. In the event of termination, you shall immediately stop any use of the
Licensed Software and destroy all copies thereof. In addition, in the event of termination because of your failure to comply
with your obligations, Philips reserves the right to invoke any and all other remedies available to it in law or contract includ-
ing the right to claim damages.

8. Applicable Law
This contract shall exclusively be governed by the laws of the Kingdom of The Netherlands without regard to its conflict of
law provisions.

9. Competent Court

The competent court for any dispute between you and Philips pursuant to this End User License Agreement is the court of
‘s-Hertogenbosch, the Netherlands.

O Philips Consumer Electronics B.V., 1999, Eindhoven, The Netherlands.
V-1991214
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Congratulations on your purchase of the Philips Seismic Edge[]
Sound Card!

Now, get ready to wake your senses . . .

. .. with high impact 3D sound from your new Seismic Edgel] sound
card. Whether your PC passion is games, music or movies, Philips
Seismic Edgel will envelope you in vibrant 3D sound from stereo
speakers, headphones or 4 channel surround speakers. Advanced
audio algorithms running on the Seismic Edges high performance
hardware accelerator support the latest 3D audio games and DVD
movies, and will transform 2-channel stereo sources like MP3 files,
music CD's, movies files, cut scenes and stereo games to deep-
immersion-surround sound.

At the heart of Seismic Edgel is a Philips ThunderBird Q3D0 audio
accelerator. This powerful DSP (Digital Signal Processor) can
process up to 128 sounds simultaneously with minimal consumption
of your computer's power. This hardware acceleration assures high
fidelity audio and frees your computer to concentrate its power on
better graphics and game speed.

Advanced DSP algorithms from QSound Labs provide compelling 3-
D for every application. If you have headphones or only two speak-
ers, Seismic Edgell's patented psycho-acoustic algorithms to enve-
lope you in a virtual sound field created from up to sixty-four inde-
pendent 3D voices.

Add rear speakers for true four-channel sound, and Seismic Edgel]
will transform your PC into your personal home theatre, with 4-chan-
nel output for 3-D games and DVDs. Plus a patented QSound algo-
rithm will transform all of your stereo sources into four distinct audio
channels including music CD's, MP3's, video files, cut scenes and
stereo games.
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Seismic Edge truly revolutionizes PC sound. "Install your sound
card", connect it to a 4-channel surround speaker system and try
these:

* Listen to your favorite music in a whole new dimension. Stereo
music CDs, MP3 files, MIDI files engulf you in 4 distinct channels
of sound.

» Play a 3-D audio enabled game and experience virtual reality

» Rediscover your favorite old 2-D games and hear them take on
new life in 3D

» Compare enhanced QMSS to Dolby Digital on DVD and hear the
difference.

Thanks for giving your computer the Philips Seismic Edge. Your
PC will never sound the same once you've given it the edge.
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Key Features

* 128 streams of DirectSound acceleration and digital mixing

* 64 streams of 3D audio acceleration including positional reverb
* Full-duplex, 48khz digital recording and playback

e Philips ThunderBird Q3D high performance audio accelerator

* Hardware DSP accelerated QSound 3D algorithms including

> QSound3DInteractivel positional 3D
o QSound Environmental Modeling for EAXUY and DS3DU
games

o QSound Multi-Speaker SystemD for quad output of
stereo sources

° QXpanderE| and "2D to 3D remapping" for 3D enhance-
ment of stereo
* 576 voice total wavetable synthesis music polyphony
o 512 Voice professional quality soft-synth with XG and GM
compatibility
o 64 channel hardware wavetable synthesizer
» Dual gameport accelerator with legacy and digital joy-stick
modes
« DirectSound", DirectSound3D!, EAXH 1.0 and A3DY 1.0
compatibility
¢ Stereo or 4 channel surround output

« QMss enhanced DVD playback mode (compatible SoftDVD
player required)

Downloaded from www.Manualslib.com manuals search engine


http://www.manualslib.com/

Philips 4-ch-091100-11-40.gxd 2000/9/11 P{?M 11: 39 Page 9
Philips Seismic Edgel @

System Requirements

Installation of your Philips Seismic EdgeD requires the following
hardware and operating system:

¢ One available PCI 2.1 compliant slot

« Intel PentiumU class or 100% compatible 133Mhz or faster
processor

+ Intel™ or 100% compatible motherboard chip set
¢ 16MB system RAM
e« CD ROM for driver installation

e Stereo or 4 channel surround powered speakers or head-
phones

«  WindowsU 95, Windows! 98, Windows NTU 4.0 (SP3)*,
Windows! 2000*

*Not all product features supported using this operating system. See
Software Installation section for details.

What's Included

You will find the following items in your Seismic EdgeIj package:
1-Seismic Edgel sound card in a anti-static pouch

1-Seismic Edgel installation CD

1-Analog audio cable to connect CD/DVD drive to sound card
1-Seismic Edgel] user's manual

1-Product registration card

Bundled applications may be included on the installation CD or on
separate media depending on the Seismic EdgeD model
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Hardware Installation
What you need for installation

Computers come in different shapes and sizes. The installation pro-
cedures in this manual apply generally and you should compare the
illustrations here with your computer before you start your sound card
installation.

¢ Sound card

¢ |nstallation CD

¢ CD Analog Audio Cable
¢ A Phillips screwdriver

¢ Have your Windows installation CD available as it may be need-
ed to complete installation of common software components.

Installing the Sound Card

Uninstall the drivers for any previously installed sound
cards. Consult your previous sound card documenta-
tion for details.

1
STATIC ELECTRICITY CAN CAUSE PERMANENT
DAMAGE TO YOUR SOUND CARD.

To prevent damage please:

1. Always hold your sound card by its edges. Avoid touch-
ing any electronic components on your sound card.

2. Use a grounding strap or touch any non-painted surface
of your computer chassis before you begin installation to
discharge static electricity

10
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To install the sound card:

1. Turn off your computer, and disconnect the power cable.
2. Disconnect all devices that are connected to the computer.
3. Remove the computer cover.

Remove the computer cover

4. Select an available PCI slot and, if necessary, remove its cover
plate. Keep the mounting screw to secure your sound card
later. Save the mounting plate for possible use later.

Select available PCI slot

11
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5.  Remove the Seismic EdgeD Sound Card from the anti-static
bag. Align your sound card with the selected PCI Bus-Slot and
firmly push it into the slot. Be sure the sound card is aligned
properly and fits snugly into the slot.

Align sound card and fit firmly into place

6. Use the screw from the slot cover to secure the sound card to
the frame of the computer chassis, but do not over-tighten.
Securing the card assures proper grounding.

Secure card with mounting screw

7. Connect the CD audio cable from your CD-ROM/DVD-ROM
drive to the sound card CD audio connector.

12
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Connecting Your Sound Card
Card Diagram

CD-IN TAD AUX In

\ J10 J
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LINEIN —
I e J13 J12

MICIN — J2

Front
Speaker * J3

AC
Loz

w (]

Rear
Speaker J4

MIDI/
N
JovsTick * JO ‘

PHILIPS

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIHIIIIIII[

Connectors for Philips Seismic EdgeEI Sound Card

EXTERNAL CONNECTORS:

J1: 3.5mm Stereo Jack for LINE IN

J2: 3.5mm Stereo Jack for MIC IN

J3: 3.5mm Stereo Jack for FRONT SPEAKER
J4: 3.5mm Stereo Jack for REAR SPEAKER
J5: Connector for MIDI/JOYSTICK

INTERNAL CONNECTORS:

J10:  Connector for CD AUDIO IN (ATAPI)
J12: Connector for AUX IN (optional)
J13:  Connector for TAD/VOICE MODEM

13
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8. Connect your audio devices to the panel of your sound card as

indicated

below:
Line-in
Micraphans Jack

| Fru_nl Gpeakers k

Rear Speakers

¥ A

MIDH { Game Fort oo "f @

LINE IN:

Connect from any external sound source such as
external CD-ROM, cassette, CD player, etc.

MICROPHONE JACK:

Connect to external microphone.

FRONT OUT:
Connect a set of powered speakers or stereo
headphones to the FRONT OUT speaker jack.

REAR OUT (optional):
Connect a pair of powered speakers to REAR
OUT speaker jack.

MIDI/GAME PORT:
Connect Joystick or MIDI device.

9. Replace computer cover and reconnect the power cable, moni-
tor, and other devices.
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Software Installation
Windows 95/98/2000 Installation

Now that the hardware is installed, it is time to configure the drivers.
Plug and Play uses your system's BIOS and the Plug and Play fea-

tures of WindowsH 95/98 to allocate resources for Philips Seismic
EdgeD.

WHICH VERSION OF WINDOWS DO YOU HAVE?

Microsoft issued a maintenance release of Windows 95 referred to
as OSR2. This version shipped as the stock operating system on
many PC's. Newer and recently upgraded PC's will have the

Windowst 98 operating system. Other systems will have the original
WindowsU 95 version. The following procedure describes installation

using Windows! 98/98SE. Windows 2000 screens are slightly dif-
ferent but the procedure is the same as described. If you have older

versions of WindowsU 95 then the installation will be slightly different
than described below.

Product Features by Operating System

Features Win 95/98 Win NT Win 2000
Headphones v v v

2 Speaker v v v

4 Speaker v v'(Except CD)

EAX1.0/A3D 1.0 v

DirectSound3D™ v v v
Analog Joysticks v v v
Digital Joysticks v

15
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TO INSTALL THE DRIVERS FOR WINDOWS!' 95/98/2000:

1. Turn on the computer and place the Philips Seismic EdgeIj CD
in your CD-ROM drive.

When the Add New Hardware Wizard dialog box reports that a
new PCI Multimedia Audio Device has been detected, click
NEXT.

Thiz vzsd r=aches [ nsw doveess foe

P bultirrecia Sudio Davics

A device diver B & poftvesre progean that makss 5
harchwans: davice work.

2. Select Search for the best driver for your device
(Recommended). Click NEXT.

16
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Ald Mo Hadwars Wiz

Yt o o vt Windows o do?

T Display & kst of al e divers in 2 speolic
lsalion. =0 wou can sslect B chiver pou want

<pack [ Wewr | conce |

3. If you are installing from the install CD or if you have copied the
install to any other location, select Specify a location and
browse to your directory where the setup files are located. For
Windows[ 95/98, select Win9x directory then choose a lan-
guage. For Windows[] 2000, select WDM directory. Click
NEXT.

Fudid Mew Hoddwoa s wWieard

i vall gedich loi new dieais i its difesn datalsaee
o o r b chivea, and nany of tha follovang seleciecd
kecatian:. Dick Hast o shat e caach

I Floppy dak, chivas

I CO-AOSE duve
T BMborosso Wirsdoas Lipdste
F Spaciy s jocaton:

[EennasEngish =]

tﬂaﬂtlﬂﬁl:l Cancel |
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4. Select NEXT to install the drivers.

Windowse direet [ls seanch for the devics:

Priips: Swsimic Edge Ao

‘Windows is now psady bo instal the best deve lor this
EM_MMMMiMM.uM Hast

Liscshion of dirver:

;q‘\!) E-Nw NS GENGLISHYOEMSE TUP IMF

_ton [T oo |

5. Windows[1 then copies the files. You may be prompted to insert
your Windows[ CD or floppy, as the core sound components of
the operating system may need to be copied as well. These
include audio Codecs, the Mixer and the Sound Recorder pro-
gram. If you are prompted with a "Version Conflict" window
regarding COMCTL32.dll, click YES to keep your existing file.

18
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Coping Fles-— |
Sournce;
E:\wWinhEnglizh\TEBIRD1 28 DLS

Destination:
C:AwWIMDDWSASYSTEMATBIRD1 28.0LS

6. The installation will continue to install the files to your system.
For Windows[ 95/98, Click FINISH.

For Windows[ 2000, you must install the Philips Seismic Edge
Audio, Philips Seismic Edge GamePort Enumerator and Philips
Seismic Edge Support Registers devices. Browse to the Driver
disk directory WDM\English to install these files. You will find these
files in the same WDM install directory and Windows[ will finish
installing the drivers for Philips Seismic Edge] automatically. Click
FINISH 3 times on each screen to install each of these devices.

19
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Adid Miew Haidwaie Wizad

ﬁ Philips Seismic Edge Audic

‘Windows has finished instaling the solftveare that yow new
Fuainaie desvice Inquies,

[CFrsh ]  cocel |

7.  After clicking 'Finish' the Philips Seismic Edge GamePort will be
installed. It is possible during gameport installation, Windows[
will detect newer versions of msanalog.vxd, vjoyd.vxd and
msjstick.drv. It is recommended that you keep your existing
files. Click YES on all 3 screens that appear.

Yersion Conflict E

A file being copied iz older than the file curently on wour
computer. It iz recommended that you keep vour exizting file.

File name: mzanalog. vxd

[ezcription: Analog Joystick Yirtual Device

Your verzion:  4.05.1.1998

Do you want to keep this file?

Mo [l bl

20
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8. Next, the software launcher will allow you to open the Seismic
Edge control panel and configure your speaker settings if
desired. Select YES to modify these settings now, or select NO
to modify later. Speaker settings are described under the Control
Panel Settings Page in this manual.

i Applications Launcher ¥1_10 E |
@ "Philips Seizmic: Edge Audia Contral Panel""

Thiz application will allow you to
zelect your speaker configuration.

Do wou wizh to launch thiz application?

Note: Any time you say No to a Applications Launcher dialog box like
the one shown above, a second box will appear asking if you
want launch the next time Windows is started. Answer Yes or

No as desired.
9. Next, the DirectXO Setup dialog box will appear. Click OK.

i Diptions:
F DirsctD Hasdwars Accelerstion Enabied

21
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Yamaha SoftSynthesizer Installation

10. After Seismic Edgel driver installation, the software launcher will
prompt you to install the Yamaha SoftSynthesizer. Click YES.

v Applications Launcher ¥1.10 Ed |
@ "vamaha SoftSunthesizer 5-Y#G5E0 Install

Do you wizh ta launch this application?

11. The Yamaha SoftSynthesizer Welcome page appears. Click
NEXT.

Yo b i TR Sedun peoqean Ty
pangram wall imatall S 0 S0 o o complier,

i gy recommerdes bl yeu el all Wirdows pegan:
e o i D St A O

mwmﬂm'umnm grans
hevs iurmeng Dce e 1o cordnua mein ﬁgi.ppq:‘q:n

"WERMING Th pacagesns s Drobeobed Dy oopssgiod ke and
interisluerul bt

et heod e resparoch oo o cisimbafion of By peogesn, OF e
pestion of i, mag ssaull i gevers crll ard cmnal peralle:, sl
wall b ] b I a=ani able urcier bass

|

12. Enter the serial number located on the Yamaha Corporation
Certificate of Authenticity included with your documentation.
This serial number is case sensitive! Click NEXT.

22
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13. The Choose Destination Location dialog box appears. Follow the
instructions in this box . Click NEXT.

Chooze Dexlinabon Lo sk

Setup vl irerdall 570350 in e follossng lolde
T inatall io i Foider, chok Mesl.

Too irtsll 5o i ciflsrent boldes. click Brosss and sslact snothar
Fiokder,

s can chiodss not 1o iretall 5 G50 by cholang Canced o et
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14. Select A Program Folder dialog box appears. Click NEXT.

Sabup vwill 5k program icore o tha Program Folder ksled bslow.
Tou & i ook Yo, (kB ol B e
Fotcs b Cich Pt 13 ot i

15. The Yamaha Software License Agreement dialog box is dis-
played. If you accept the terms and conditions, Click YES.

24
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16. You must restart your computer at this time. Click OK.

Restarting Windows

25
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17. Next, the software launcher allows you to install Sonic Foundry
SIREN Jukebox Xpress. This application allows you to play and
organize music. Click YES on the dialog box and follow the
installation screens to install this software. See section About
SIREN Jukebox Express to learn more about this application.

18. Product Registration If you are connected to the internet, you
can register your product now by clicking YES in the dialog win-
dow shown below. If you prefer to register your product at a
later time, go to:
www.philipsusa.com/prod_reg_bounce.html and follow the
instructions.

v Applications Launcher ¥1.10 ] |

® "Philips Product Registration 'Website"

YWie can launch your [nternet browser to take you
to the Philips Product R egistration ' ebszite.

Do pow wizh to launch thiz application?

Ha |

CONGRATULATIONS! You have successfully installed your
Philips Seismic Edge.
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Windows NTU Installation

Installation of the drivers for your Philips Seismic Edge PCI Audio in

a Windows NTU environment are as follows (note: you must have
the appropriate privileges in order to install the drivers):

¢ Boot the system to the Windows NTD desktop.

¢ Go to D:\ NT40\ English\ and double click on Setup.exe (D: repre-
sents your CD-ROM drive.)

* Wait a couple of minutes while the data transfers. Once it finishes
the Philips Seismic Edge Settings window will appear. Click OK on
the settings page and then when the "System Settings Change"
page comes up and prompts you to restart, click the "Restart
Computer Now" button.

That's it! Once the system reboots to Windows NTD your Philips
Seismic EdgeIj should be fully functional as will be indicated by the
WindowsU Startup sound.

Yamaha SoftSynthesizer Installation for Windows NTU

Follow these steps to install the Yamaha SoftSynthesizer from your
install CD:

1) Insert your install CD into your CD drive

2) Go to D:\S-yxg50\Nt40\Disk1\ (D: represents your CD-ROM
drive)

3) Double Click on Setup.exe

4) Follow the on-screen instructions for installation. The required
serial number is located on the Yamaha Corporation Certificate of
Authenticity included with your documentation.

Siren XPress Installation for Windows NTH

Follow these steps to install the Siren XPress. This application
allows you to play and organize music.

27
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1) Insert your install CD into your CD drive

2) Go to D:\Applications\Sonic Foundry\Siren\
(D: represents your CD-ROM drive)

3) Double Click on SirenSetup.exe

4) Follow the on-screen instructions for installation

Real Mode DOS Installation (Optional)

This step is only required if you intend to run DOS applications under
real DOS mode by restarting your computer in "MS-DOS mode".
This step is not required to run DOS applications in a DOS box (MS-
DOS prompt).

In real DOS mode, you must have your DOS CD-ROM drivers loaded
for access to the install CD. Another way to do this is to simply run
INST_DOS.BAT from a DOS box in Windows.

Run INST_DOS.BAT from the DOS directory on the CD. This instal-
lation program will create the TBird directory on any drive you desire.
Follow the screen prompts to install the files to your hard drive. The
install program will edit your autoexec.bat file to perform automatic
initialization of Philips Seismic Edgel for use in real mode DOS.

Using the Philips Seismic Edge Control Panel for DOS

To launch the DOS control panel:

1. Go to C:\Seismic\ (C: represents your hard drive)
2. Type VOLCNTRL.EXE

This application allows you to adjust volume levels, balance, input
levels, synthesizer modes, speaker modes, and midi effects in real
DOS.

In DOS games that have music settings, if you select FM synthesis in
the game, make sure the synth control in the control panel is set to
OPL3. For games that support MIDI (mpu-401), select the WVTBL
(wavetable) option. The game publisher normally has this information
in the program documentation.
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NOTE: This application is for real MS-DOS mode only and should

not be run under windows. In Windows[, use the WindowsD mixer
for adjusting playback and recording levels.

Joystick Configuration for Windows" 95/98/2000:

1. Open the Control Panel and double-click on the Game
Controllers icon. Select the Advanced tab and under Port
Driver Assignment and select Philips Seismic Edge GamePort.

fd; Game Controllers HE |

General Advanced |

— Contraller 1D &zzighment

To modity the contioller |D, select the D and click Change.

1] | M ame | Game Contrallers | -

1 2-axis, 4-buttan jopstick 2-avis, 4-buttaon jopstick

2 [mone] [Fione] |
3 [mone] [Fione]

| [rione] [rione]

5 [nane] [nane]

B [nane] [nane] LI

Change... |

— Part Driver Azsignment

|f pour game controller port requires a specific port driver, select it from
the lizt below.

Bort Drivver: hilips Seizmic: Edge GamePart
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2. Select the General tab and click the Add button. You may select
any one of the Game Controllers listed, then click OK.

j-:’! T k] b gl cordiodin, sl the corlioler bitoer and chek. DK

Gsrme Controlers

CE x|
IF ponr games cornbolier does redl Spiear i k6l sboe, ook 2ad Other,

-ﬁdl:llillhn'..l
[ ] |
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3.  After making your selection, highlight the selected controller in
Game Controllers and click the Properties button. Select

Calibrate and calibrate your joystick. Your joystick should be
installed and ready for flight!
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TECHNICAL SUPPORT

Before calling the technical support number please make sure you
have the following information available:

. Model and serial number (located on the inside front cover of
the user manual or on the warranty card) and date of purchase.

. Computer type, processor speed, and memory available.

. Computer Operating System (IE: Windows™ 95, WindowsU 98,
etc.)

. On-screen error information.

. Other hardware sound card is connected to.

Technical Support Information:

. Toll-Free Telephone Number: 1-800-835-3506

. Operating Hours (US Central Time):
* Monday through Friday 7:00am -11:00pm
e Saturday & Sunday 8:00am -10:00pm

- Internet Address: www.philipsusa.com
Product Return

Before returning the Philips sound card, you must first contact the
Philips Technical Support group to determine the nature of product
defect. Once the nature of the problem has been determined, a
Return Authorization number and address will be supplied. A
RETURN AUTHORIZATION NUMBER MUST ACCOMPANY THE
RETURN OF THIS PRODUCT.

When returning the product for service:

. The cost of shipment is at your expense and you assume all the
risk. It is recommended to ship the product through a carrier
that provides proof of delivery and product should be insured.

. Return Authorization number must be clearly marked on the
outside of the package.

. Use proper packing materials for shipment

. A dated proof of purchase proving the product is still under
Warranty

Warranty: 3-year limited warranty
32
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Philips Seismic Edgel Control Panel

1. Control Panel Tab Windows! Audio Applications

Just click on the desired Windows! applet to launch.

Philipz Seizsmic Edge Audio Control Panel

Control Panel | Demo | Settings | MIDI | GEM |

B &

Walume Control Sound hedia Player

Recarder

CD Player Multimedia

¥ Show tray contral on the taskbar

Seismicledge)

pH Ill ps Q' )4 I Cancel
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2. Demo Tab

These are links to the applications found on the installation CD, so
make sure the CD is inserted in your CD-ROM drive before launch-
ing.

Space Junk
A 3D audio application that demonstrates QSound Q3D0O technology.

Wumpus
A 3D audio game that also demonstrates QSound's technology.

Philips Seismic Edge Audio Control Panel

Contiol Panel Demo | Settings | MIDI | GEM |

o v

Space Junk, WwWumpus

sSeismiciedge)]

PHILIPS @ —— —==
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3. Settings Tab
This control allows you to select what output mode to use.

Headphone Mode
Utilizes the Q3D0O for headphones algorithm for a personal 3D audio
experience.

2 Speaker Mode
Default mode, this setting is for 2 speaker setups and uses the Q3D
2 speaker algorithm.

2D to 3D Remapping

This feature affects DirectSound and MIDI WaveTable
sources. Converts 2D stereo panning to 3D audio output.
QXpander™

This feature enhances CD and DVD audio by converting nor-
mal stereo sources to expanded 3D audio.
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Philipz Seizmic Edge Audio Control Panel

I | Gzl fon D5 andleudio ik

SEELRE EEEE

For 4 speaker setups (left front, right front, left rear, right rear) select
"Quad output mode". This will enable quadraphonic playback for 3D
applications. Stereo (2D) will also be automatically converted to
quadraphonic including games, cut scenes, midi files, sound (.wav)
files and movie (.avi) files using QSound Multi-Speaker System[
(QMSSIy .
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Audio CD's and audio DVD's can also be played in quad if the Quad
for DVD and Audio CD's box is checked. The QMSS box does not
have to be checked for other stereo and 3D sources, it only must be
checked for audio CD/DVD's.

Philipz Seizmic Edge Audio Control Panel

[
1= | 20 b 3 [ Dt S aurdy
7| W manden fonsudio El
o

SEEE EEEE
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4. MIDI Tab

NOTE!: When your card is initially installed the SXG Softsynth
is selected as your MIDI engine. The SXG IS NOT CON-
TROLLED ON THIS TAB BUT IN A SEPARATE CONTROL PANEL.
See details below.

Your Seismic EdgeD sound card includes two distinct wavetable
music synthesis engines. The Yamaha SXG is an extremely high
quality, high polyphony (512 simultaneous voices) MIDI synthesis
engine with both GM and XG compatibility. Select the SXG for the
richest music experience. The Seismic Edge WaveTable Synth is a
pure hardware synthesis engine designed for use with games or
other applications where low CPU consumption is critical. Select the
Seismic Edge WaveTable Synth only for games that utilize MIDI for
music. Note that most current PC games do not use MIDI music so
typically the SXG Softsynth can be left selected even when playing
games. These games use digital sound recordings exclusively and
are not effected by MIDI output selection.

When your card is initially installed the SXG Softsynth is selected as
your MIDI engine. To view or change your selection:

Select "Start" then "Settings" on the Windows Taskbar.
Double click on the Multimedia properties icon.

Select the MIDI tab.

"Single instrument" will be selected

Look at the box under "Single instrument" to determine what
MIDI output (engine) is currently selected.

6. To change to a different MIDI output select it then select
"Apply" or "OK". You can select either "Yamaha SXG Driver"
(typical), "Seismic Edge WaveTable Synth" (games with
MIDI) or Seismic Edge External (if you have an external
synthesizer connected to the Game/MIDI port of the card).

kRN

To adjust the SXG Softsynth:

1. The SXG is not affected by the controls under the MIDI tab of
the Seismic Edge control panel.
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2. Right click on the "XG Soft" icon in the systray or in the control
panel.
3. Select "SoftSynthesizer Setup" or "Open" if in the control panel.

To adjust Seismic Edge WaveTable synth:

1. Open the Seismic Edge control panel by double clicking on the
"Edge" icon in the systray.

2. Select the MIDI Tab

3. Selected the desired mode.

Philipz Seizmic Edge Audio Control Panel

(e iarie
A 2

) Besvert

SEIENE EEEE
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Game Mode (Default, Recommended)

Best setting for Windows! DirectSound" and DirectSound3D
Gaming. Maximum hardware acceleration for games.

Studio Mode
Setting for improved MIDI WaveTable playback with effects.
Moderate DirectSound acceleration.

Max Polyphony Mode

Setting for the best MIDI WaveTable polyphony.

Minimum DirectSound Acceleration.

You will only notice an effect if your file is high polyphony (i.e. using a
large number of voices simultaneous).
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5. QEM Tab

Philipz Seizmic Edge Audio Control Panel

SEELE EEEE
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WHAT IS QEM?

QEM (QSound Environmental Modeling) is an environmental audio
rendering engine providing reverberation and other special audio
effects. It is compatible with the EAXO API (Application
Programming Interface) provided to software developers by Creative
Labs, Inc.

WHAT DOES QEM DO?

In real life, every room, or "environment" you enter has some sort of
reverberant quality, depending on different factors like its size, and
the material the surrounding objects (e.g. walls, mountains, etc.) are
made of.

QEM attempts to model this in a game world, by applying reverb
effects to DirectSound audio streams, by way of presets that can be
either set manually, or called automatically from within an "EAX-
enabled" game.

How QEM Works

N

YES

® Ervironment will

& Environmant will ba changs according

as sel in Conbhol
Faneal Dafault :: E':};:ﬂ; eade

* [ iz not dynamic & |13 dynamec

From a game player's perspective, this means that they can get ambi-
ent reverb effects on all the Direct Sound games they play. With the
Philips Seismic Edge, there are 2 ways they could get this:
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QEM FOR A "EAX-ENABLED" DIRECT SOUND GAME

Follow these simple steps to enable EAX:

1. Open the Philips Seismic Edge control panel

2. Click on the QEM tab

3. Make sure the QEM checkbox is selected. From the Default
Environment list, if None is selected, the title will automatically
adjust reverb qualities and no other end-user adjustments are
necessary.

Click "OK”

Start game

If required, select EAX in game set-up options

Disable QEM checkbox after exiting game to avoid QEM from
affecting other applications.

No oM

QEM FOR A NON-EAX DIRECT SOUND GAME

If your game does not support QEM (i.e. non EAX-Enabled Direct
Sound games), select a suitable reverb from the Default Environment
list in the Philips Seismic Edge control panel, and run the game.
Follow these simple steps.

Open the Philips Seismic Edge control panel.
Click on the QEM tab.

Select the QEM check box.

Select a preset from the Default Environment list.
Click "OK".

Play your game.

Disable QEM checkbox after exiting game to avoid QEM from
affecting other applications.

No o~
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DVD Playback Modes

Using 4 channel surround speakers your Seismic Edgel sound card
can deliver true multi-channel surround sound from a compatible
soft-DVD player application even if the player only supports stereo
output. If the soft-DVD player is capable of providing a true 4 chan-
nel Dolby Digitall] downmix Seismic Edge will output 4 channels.
Even if the soft-DVD player supports 4 channel Dolby Digital(l you
may prefer using QMSSO playback of DVD's because of the
enhanced rear channel content it provides. If you have only stereo
speakers Seismic Edge can also provide virtual surround using it's
2D to 3D remapping feature.

To enable 4 speaker QMsst DVD enhancement:

1)  Make sure "4 Speakers" is selected in the Seismic Edge control
panel settings tab.

2) Open the "control panel" or settings menu for the soft-DVD
player.

3) Select the menu or tab that controls the player's audio settings.

4) Look for a panel that allows you to select the number and type
audio channels

5) Select either 2 speaker "Stereo" or 2 speaker "Dolby Surround

or ProLogic" Either option will work well as the QmvssH psp
algorithm does not depend on Dolby encoding. (Effectively you
should follow the soft-DVD player instructions for playing back
over stereo speakers even though you have quad speakers
connected).

6) Close the control panel and play a DVD. Seismic Edge will

detect that it is in 4 speaker mode but is only receiving two
channels of audio from the DVD and automatically generate 4

distinct channels of surround sound using Qmsst.

To enable a 4 speaker Dolby DigitalIj downmix :

1)  Make sure "4 Speakers" is selected in the Seismic Edge control
panel settings tab.

44

Downloaded from www.Manualslib.com manuals search engine


http://www.manualslib.com/

Philips 4-ch-091100-11-40.gxd 2000/9/11 P{?M 11: 39 Page 45
Philips Seismic Edgel @

2) Follow the soft-DVD players instructions for 4 speaker playback.
(Some players will not offer this feature)

3) Play a DVD and Seismic edge will output the 4 channel Dolby
Digital downmix provided by the soft-DVD player.

4) Seismic Edge supports Microsoft's standards for multichannel
playback however some soft-DVD players may not. If this mode
does not work with your soft-DVD player then use QMSS DVD
enhancement mode described in the preceding section.

If you only have stereo speakers:

1) Make sure "2 speakers" is selected in the Seismic Edge control
panel settings tab.

2) Select "2D to 3D" under "2 speakers" in the Seismic Edge con-
trol panel.

3) Follow the soft-DVD players instructions for "stereo" playback. Do
not select the 3D option if it exists as it may interfere with the 2D
to 3D remapping feature. (Alternatively do not select 2D to 3D in
the Seismic Edge control panel and select the soft-DVD players
3D option to use the players built in 3D virtualization capability)

4) Play a DVD and Seismic Edge will virtualize surround effects
coming from the DVD.
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About SIRENC XPress

Transform your PC into the ultimate music entertainment center with
SIREN XPress music jukebox. SIREN XPress lets you "rip" your CD
collection onto one convenient location-our hard drive. Let SIREN
XPress help you surf the net and find more great music to add to your
collection-MP3, WAV, and WMA files are all supported. Use SIREN
XPress’ advanced organizational features to create custom playlists
of the songs you want to hear. SIREN XPress maximizes your audio
experience with dazzling, colorful eye candy real-time computer ani-
mation that pulses and interacts with your songs. And when you're
ready to hit the road with your portable MP3 player,* SIREN XPress is
the fun, easy way to upload your custom playlists.

* Supported MP3 players do not currently run under Windows NTU or

Windows2000. You must be running SIREN XPress on Windows!
9x to upload songs to portable players.

SIREN XPress includes 20 free MP3 encodes, with unlimited MP3
playback.

SIREN XPress makes it easy to organize your music:
* SIREN XPress includes a powerful, database-driven music man-
agement engine.

* The Sort, Group, and Filter tools provide you with superior control
over your music library.

* Use the Field Chooser window to view your collection the way you
want to see it.

SIREN XPress brings powerful functionality to your desktop:

® Use Search for Music to find music on a network or removable
drive.

® Export custom playlists to your Rio or Nomad Il portable MP3
device.

* Use your Microsoft Internet Keyboard hotkeys to control SIREN
XPress's functions.
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Siren] XPress Quick Start

Welcome to Sonic Foundry's Siren XPress! This guide is designed to
provide you with information that will allow you to immediately begin
taking advantage of the powerful features of Siren XPress.

Siren XPress allows you to operate in Philips compact mode or nor-
mal mode. The compact mode includes only the Transport buttons
(Play, Stop, Pause, etc.). The normal mode displays the entire Siren
XPress window, and allows access to all Siren XPress functionality.
You can toggle between the Philips compact mode and normal mode
using any of the following methods:

® Click the Compact/Skin Mode button.
* Choose the Compact/Skin Mode option from the View menu.
* Press Ctrl + M on your keyboard.

You can expand the Philips compact mode to display the current and
next songs, the Compact/Skin Mode button, and the Select
Playlist button. To expand the compact mode, click the Expand con-
trol on the right end of the player. You can also use this control to col-
lapse the compact mode. The Siren XPress expanded compact mode
is shown below:

o v

=T ).._ -
e o
. P

Lt gy ey

.y - Fampn ulion Fimar i Pl

Music Files

A music file refers to any audio file that Siren will play from your com-
puter. Siren supports the following music file formats: *.wav, *.mp3,
*.wma.

Finding Music

After you install Siren XPress, a configuration wizard will scan your
local hard drives for any *.mp3, *.wma, and *.wav files, and add them
to your Siren XPress music library. If you are unable to play music or
use the transport controls for Siren XPress after the installation
process, you can manually run the Configuration Wizard from Siren's
normal mode by choosing Configuration Wizard from the Options
menu.
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You can also search your hard drive(s) for music to add to your
music library any time by choosing Search Computer for Music from
the Options menu.

Playing Music
Siren will allow you to play *.mp3, *.wma, and *.wav files, as well as

audio CDs. You can start playing music immediately by clicking on
the Play button in either compact or normal mode.

Playing music by type

With the compact mode expanded, click on the Select Playlist but-
ton. From the menu that displays, you can select your music by
Album, Artist, Genre, or Playlist, or choose to play an Audio CD.

Transport Controls

Depending on your recent activities the transport controls (Play,
Pause, Next Song . . . ) will effect either music file playback or CD
playback. To switch all the transport controls to CD playback click
the Select Playlists button, select Audio CD, then click Play to start
CD playback. To switch the transport controls to music file playback
click the Select Playlists button, select My Music or My Playlists
and then the desired music files. Playback will start immediately and
all the transport buttons will now effect music file playback except for

the Play button. The Play button will continue to start CD playback
until you go into normal (full window) mode and select a different icon

than Play or Record Music CDs.

Graphic Effects

Siren XPress displays dazzling visual effects during audio playback.
Siren XPress defaults to random visual effects. To choose a particu-
lar effects pattern, right-click on the visual display and choose from
the list of available graphic effects.

Recording from a CD

1. Place an audio CD in your computer's CD-ROM drive.

2. In normal mode, choose Play or Record Music CDs from the
View menu. Your computer's CD drives are displayed in the
Explorer panel.

3. In the drop-down list in the Explorer panel, specify the CD
drive containing the audio CD. The CD's tracks are displayed
in the Explorer panel, and Siren attempts to access information
for the CD. If the CD information does not appear, you can
obtain the CD information by clicking the CDDB button, or you
can add the information manually in the Explorer panel. If the
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CD information is not accessed or added manually, Siren
records the songs as "Unknown" and numbers them sequentially.

4. Select the song(s) to be recorded.

5.  From the File menu, choose Record to Library. Siren begins
recording files to the folder specified in the Preferences dialog,
and a meter in the Status panel depicts the progress of the
recording.

6. To halt recording at any time, choose Cancel Recording from
the File menu.

7.  To monitor the recording progress, select Recording List from
the Explorer panel drop-down list, or, if Tree View is enabled,
double-click on the Recording List folder.

Note: You can play music from the music library while you are
recording CDs, but you cannot listen to the CD itself during recording.

Additional Help

For more detailed information about Siren XPress features, please
refer to the online Help file accessible from Siren's normal mode by
clicking the Help menu and choosing Contents and Index.

For additional information on other Sonic Foundry products, visit
www.sonicfoundry.com.

Upgrading to Siren Jukebox

If you like Siren XPress, but want more powerful options, get these
additional features when you upgrade to Sonic Foundry's Siren
Jukebox:

. CD burning
. Unlimited MP3 ripping
*  Advanced audio effects

To upgrade, choose Instant Upgrade from the Help menu.

About AudioPix[

AudioPixO makes it easy to combine digital images with MP3
sound to get the ultimate multimedia presentation. In just three
simple steps you will have an exciting new MPEG format that can

be played back in either of the popular players, ReaIPIayerD or

Windows" Medial Player. Now for the first time, you don't have to
be a Web Master to create your own unique presentations - just
grab an MP3 file, some of your most treasured images and let your
imagination go.
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Turn your wedding photos and special occasions into a creative
slideshow for friends and family

Keep your vacation memories alive forever. Go on vacation
without going on vacation!

Create an "Internet Commercial" to promote your business

To install AudioPix, follow these simple steps:

1)
2)

3)
4)

Insert your install CD into your CD drive

Go to D:\Applications\QSound Labs\AudioPix\ (D represents
your CD-ROM drive)

Double click on apixfree.exe

Follow the on-screen instructions for installation. The required
serial number is located at D:\Applications\QSound
Labs\AudioPix\ Open the apixfree.ixt file.

Recording Source Configuration

Philips Seismic Edgel allows you to record sounds and music from
various input sources (i.e. microphone, audio CD, line in, etc). Before
you start recording, you need to configure the recording source as
follow:

Open the Volume Mixer, go to Options, and select Properties.
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®  Choose Recording under "Adjust Volume for", and check the
recording source that you want to display in the Recording
Mixer.

®* Click OK, and the Recording Mixer window will open. Now you
can select the recording source you intend to use and adjust the
recording volume level.

. Open your favorite recording application and start recording.
51
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Frequently Asked Questions

This section highlights some of the more commonly asked questions
and their possible solutions. Reviewing this chapter can help you
solve many problems and often eliminate the need for telephone
assistance.

Will Philips Seismic Edgel] work on all motherboards ?

Philips Seismic Edgel] is a PCI based solution for audio acceleration
and requires a Pentium class motherboard with one available PCI
slot for operation. Most chipsets found on commercially available
motherboards and in pre-built systems are compatible with Philips
Seismic Edge] Audio. See Minimum System Requirements in this
manual.

Is Philips Seismic Edgel full-duplex capable?

Full duplex is the ability for a sound card to record and playback
audio at the same time. Philips Seismic Edge is able to do this
while maintaining full 16-bit 48KHz sound quality.

What wave file types is Philips Seismic Edge] compatible with
(ie. what wave types can it playback)?

Basically all wave file types you are likely to encounter will work fine.
Most of the supported sample rates of audio applications such as

SoundForge or the Windows! Media Player are supported, although
it is possible that in a very rare instance you might encounter a non-
standard file format that may not work.

What version of DirectX should be installed?

For most applications and particularly for games, it is recommended
that you run DirectX 6.0 or higher.
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Do | need to connect all 4 speakers at the same time?

You do not need to connect all 4 speakers to enable your sound out-
put. You can have only the front speakers connected. This will how-
ever reduce the feel of the positional 3D sound sensations.

Why isn't there any sound from the speakers?
Go through the following steps:

1. Make sure your speakers are connected to your computer is as
described in Hardware Installation - External Connections.

2. Your speakers should be active speakers (speakers with exter-
nal power supply). Passive speakers may result in unacceptably
low volume and distortion.

3.  The Output Mode (Philips Seismic Edgeld Control Panel Applet
Settings tab) must be set to Speaker if you are using only the 2
front speakers. It must be set to Quad if you are using 4
speakers.

How do | uninstall the audio drivers?

See Uninstalling Software Drivers of this user manual.

My system does not detect the sound card when | boot up for
the first time. What's wrong?

Windows ™' 95/98:
Make sure your sound card is fully inserted into the PCI Bus slot.

1. From the Windows task bar, click Start>Settings>Control

Panel.

Double-click System icon.

Click the Device Manager tab.

Click on Sound, Video and Game Controllers

Check whether there is any yellow exclamation mark (error) on
each of the Philips Seismic Edgel] devices. If there is, remove
all devices (by highlighting the device and clicking Remove) and
re-install the sound card drivers.

abkowh
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Windows NTH

Not applicable.

| don't hear any music in my DOS game

In DOS games that have music settings, if you select FM synthesis in
the game, make sure the synth control in the control panel is set to

OPL3. For games that support MIDI (mpu-401), select the WVTBL
(wavetable) option.
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RESOLVING 1/0 CONFLICTS

Conflicts between your audio card and another device may occur if
they are set to use the same 1/O address. To resolve I/O conflicts,
change the resource settings of your Philips Seismic Edge™ card or

the conflicting device using Device Manager in Windows 95/98.

If you are still unable to determine which card is causing the conflict,
remove all cards except the Philips Seismic Edge™ card and other
essential cards (for example, disk controller and graphics cards).
Add each card back until Device Manager indicates that a conflict
has occurred.

To resolve conflicts in WindowsH 95/98

1. Click the Start button, point to Settings, and then click Control
Panel.

2. In the Control Panel window, double-click the System icon.

In the System Properties dialog, click the Device manager tab.

4. Under the Sound, Video and Game Controllers entry, select the
conflicting audio card driver, indicated by an exclamation mark
(1), and click the Properties button.

5. In the Properties dialog, click the Resources tab.

Select Use Automatic Settings and click the OK button.

e

o

7. Restart your computer to allow Windows™ 95/98 to reassign
resources to the devices.

Uninstalling Software Drivers
Windows" 95/98 Uninstall

1. Select Control Panel, Add/Remove Programs and select Philips
Seismic Edge Audio Support Files. Click the Add/Remove button.

2. You will be prompted to shutdown your computer after uninstall
for the changes to take effect. Click Yes to shutdown your com-
puter and then remove Philips Seismic Edged from your system.
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Windows NTH Uninstall

Browse to the Multimedia page in the Control Panel, click on the
"Devices" tab, under "Audio Devices" select "Philips Seismic Edge
Audio", and then click the "Remove" button. Shutdown your computer
and remove Philips Seismic Edge™ from your system.

Windows! 2000 Uninstall

Open the Add/Remove Hardware control panel applet

Select "Uninstall/Unplug a Device". Click Next.

Select "Uninstall a Device". Click Next.

Choose Philips Seismic Edge Audio from the list. Click Next.
Click Yes on confirm screen. Click Next.

Open the Add/Remove Hardware control panel applet

Select "Uninstall/Unplug a Device". Click Next.

Select "Uninstall a Device". Click Next.

Choose Philips Seismic Edge Game Port Enumerator from
the list. Click Next.

10. Click Yes on the confirm screen. Click Next.

11. Open the Add/ Remove Hardware control panel applet
12. Select "Uninstall/Unplug a Device". Click Next.

13. Select "Uninstall a Device". Click Next.

14. Choose Philips Seismic Edge Support Registers from the list.
Click Next.

15. Click Yes on the confirm screen. Click Next.
16. Open the Add / Remove Programs control panel applet

17. Click on Philips Seismic Support Files. Click
Change/Remove.

18. Power down your computer and remove your sound card.

© e NN~
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Certification Information

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residen-
tial installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used
in accordance with the instructions, may cause harmful interference to radio communications. However, this notice is
not a guarantee that interference will not occur in a particular installation. If this equipment does cause harmful inter-
ference to radio or television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try one or more of the following measures:

1. Reorient or relocate the receiving antenna

2. Increase the separation between the equipment and receiver.

3. Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.
4. Consult the dealer or an experienced radio/TV technician.

CAUTION: To comply with the limites for the Class B digital device, pursuant to Part 15 of the FCC Rules, this device
must be installed in computer equipment certified to comply with the Class B limits.

Al cables used to connect the computer and peripherals must be shielded and grouded. Operation with non-certified
computers or non-shielded cables may result in interference to radio or television reception.

Modifications

Any changes or modifications not expressly approved by the grantee of this device could void the user's authority to
operate the device.
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Declaration of Conformity

FCC ID: LWHA481P2

According to the FCC96 208 and ET95-19

Name Labway Corporation
Address: 7F, 150, Jian Yi Road
Chung Ho
Taipei Hsien,
Taiwan, R.0.C.

declares under its sole responsibility that the product
Trade Name: Philips Consumer Electronics Company / Labway Corporation
Model Number: PSC70417 / A481-P20

has been tested according to the FCC / CISPR22/85 requirement for Class B devices and found compliant with the
following standards:

EMI/EMC: ANSI C63.4 1992, FCC Part 15 Subpart B
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:
1. This device may not cause harmful interference, and

2. This device must accept an interference received, including interference that may cause undesirable operation.
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Notes:
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